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1 Introduction

Welcome and thank you for purchasing Sign Builder DE (Desktop Edition).

Sign Builder DE is a software tool designed to produce custom signs. It can
build professional quality signs for practically any situation. Sign Builder DE
offers the flexibility to create ANSI, ISO, OSHA and other general-purpose
signs. With an extensive library consisting of over 6000 unique high quality
symbols, pictograms and signal word headers, nearly any sign you can imagine
can be created using the Sign Builder DE software. Since it utilizes high quality
vector graphics, signs built with Sign Builder DE will not distort and will not lose image quality as
size is increased. Sign sizing and printing is flexible and is constrained only by the users’
printing capability.

This manual is provided to help you get started and offers a complete reference of the software
capabilities and resources. In addition to the basics, discussed are different standards and
regulations that most people should observe when creating safety signage. Understanding
these standards will better assist you in creating effective compliant safety signs.
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2 Installation and Setup

This chapter covers initial requirements and software installation necessary prior to using Sign
Builder DE. It presents the following topics:

System Requirements
Installation

Running for the First Time
Registration

21  System Requirements

Sign Builder DE is a Windows™ application with very modest system N
requirements as follows:

DANGER
/ PINCH
- POINT

e A computer running Windows NT, 2000, XP, Vista or later.
¢ 100 megabytes of hard drive space.
e A printer for sign output.

2.2 Installation

To install Sign Builder DE on your computer, you must first run the Sign Builder DE installation
utility SignBuilderDE_Installer.exe provided to you at time of purchase. Double-click on the

installer and follow the instructions presented in the dialogs. When the installation utility
completes, Sign Builder DE will be installed on your computer.

2.3 Running for The First Time

To run Sign Builder DE, use the Windows Start menu, navigate to Programs > Sign Builder
Desktop Edition and click on Sign Builder.

@’ Set Program Access and Defaulks

£y Documents

©
5 L
B [ sign Builder Manual
0 G-‘ Settings 3 =
%-‘ ~ #P Uninstal
By - search r
& &) Help and Support
I
H =7~
°
=
hDI Shut Down...

Running Sign Builder DE

www.stclaire.com Page 4



)

l s%ﬁﬁg
BUILDER?® Deskiop Edition

By default, the Sign Builder DE software behaves as an evaluation copy and will function with
limited capabilities until registered.

Safety Sign Builder, - Evaluation Yersion

File Edt Freview Tools Help

Layout

ola ajm  m sex[ 10ofnhes &
Message

CEEE so

YOUR MESSAGE HERE

Safety Sipn Builder

This is an evaluation version of Safety Sign Builder,
—MNOHEADER — ! Y ouwill nat be able to print and the pictogram ibraries are limited.

& Wste-c\Canon IRCS1E0PS ([ 85" bw 11" Q4 Edit

Sign Builder DE Main Window Before Registration

2.4 Registration

To unlock the full capabilities of Sign Builder DE, the software must be registered. A proper
registration license is provided to you with your purchase. Register by selecting Tools >
Register Sign Builder at the main window pulldown menu. This will open the Safety Sign
Builder Registration Window where you can enter your name and license key.

& Safety Sign Builder, Registration g@@

Enter Registered Owner's Name:
Johr Doe

NOTE: Enter your name exactly as you did when purchased

Enter License Key:
ET41Y w9556 BIEFE B3HHS|

Registration Window

A unique license key is required for each installed instance of Sign Builder DE. Please review
the Sign Builder DE licensing information (Appendix E) for details. After entering the registration

information, click OK and restart the program. You are now ready to use Sign Builder to its full
potential.
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3 Your First Sign

NOTE: This section provides a quick refresher or a brief reference of how to build a sign using
Sign Builder DE. Refer to Section 4 for in-depth description of software functions.

Building a sign using Sign Builder DE is very easy and the result is always of the highest quality.
To get an idea of what is involved, follow the illustrated instructions below to build your first sign

using Sign Builder DE.

3.1  Sign Message

Each sign may contain a message that is communicated to the observer. Let's assume that your
first sign needs to communicate the message “Electrical Hazard”. Type the message in the
Message area as shown below and click on the Bl Preview Sign button. This displays the
Preview pane where the sign would be displayed. As you can see, the message is displayed as
large as possible and centered within the available space.

Safety Sign Builder E)E)X] [ & safety sign Builder
File Edit Preview Tools Help File Edit Preview Tools Help
Layout PE—— Layout p——
o njm ®[ sk 0fme & ; p=If-1 B[ o2k 107 ]
Message — Preview Edit S|gn —
NEEEE
Electrical Hazard. |
Header
| PreviewSign ||| - .
[-HovEADER- 4 [ Edit Sign Message | Electrical
Pictogram
= = Hazard.
& Shate-chCanon iRCST80PS [ 85"by 11" |G Edit & ShstorchCanon RCS180PS [ B5"by 11" |G 26% Preview
Edit Window Preview Pane

Add Sign Message

3.2 Sign Header

In order to emphasize the importance of the message, most safety signs use a sign header
(also known as signal word) to indicate a hazard level. In the case of your first sign, the hazard
level can best be described as “Danger’. To include an appropriate header, click on the 2| Edit
Sign button to exit the preview pane and return to the edit window. From the Header area
select “DANGER (ANSI, EN)”. You will see a red Danger header displayed to the right.
Appendix B provides a complete reference of available headers.
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Safety Sign Builder
File Edit Preview Tools Help

Layout

Message

N R

als mlm @ okl wle s

Safety Sign Builden

File Edit Preview Tools

Y Layout
— -S4 g
. ||EE
Preview

Arial

|Electri|:ﬂl Hazard.

Header

ANSI 3

DANGER (ANSL EN)

Pictogram

[Select Sign Header]|

& iste-c\CanoniRCS180PS |[) 85 by 11" Q4 Edit

Help

@) sex[ 0w @

Electrical
Hazard.

& Muste-chCanon ACE180PS |[) B.5"by 11" | Q 26% Preview

Add Sign Header

To preview the updated sign, click on the 8| Preview Sign button. You'll now notice that the
sign includes the selected header with the message resized and repositioned to accommodate

the changes.

3.3

Sign Pictogram

To further improve the effectiveness of our sign, it is appropriate to add a pictogram that would
provide visual clues to the danger associated with Electrical Hazard. Click on the | Edit Sign
button to exit the preview pane and return to the edit window. From the Pictogram area click on
the B Select Left/Top Pictogram From Library button to open the Pictogram Browser
window. Using the Pictogram Browser, select the ELECTRICAL HAZARDS library and the
Electrical Hazards - 037 pictogram as shown below. Click the Use button to accept the current
selection. Appendix C provides a complete reference of available pictograms.

Libraries: Pictograms:
ARROWS BLACK ~| |Electical Hazards - 019 ~
ARROWS BLUE Electrical Hazards - 020

ARROWS GENERAL
ARROWS GREEN
ARROWS DUTLINED

Electrical Hazards - 021
Electrical Hazards - 022

ﬁs/i%\/E\fiERSESD Electrical Hazards - 023
Electrical Hazards - 024

CHEMISTRY

COMMON HAZARDS Electrical Hazards - 025

DAMGER Electrical Hazards - 026

DOT HAZARDS & Electrical Hazards - 027

Electrical Hazards - 028

RDS B
A ARDS

Electrical Hazards - 029
Electrical Hazards - 030
Electrical Hazards - 031
Electrical Hazards - 032

FIRE CONTROL A
FIRE CONTROL B
FIRST AID

Electrical Hazards - 033
Electrical Hazards - 034
Electrical Hazards - 035
Electrical Hazards - 036

HAMDS & FEET
HOUSEKEEPING & RECYCLING
INDUSTRIAL
INFORMATIONAL - BLUE
INJURY HAZARDS

LOCKOUT TAGOUT

LODGING & TRAVELING
M&CHINERY HAZARDS

Electical Hazards - 0138

MANDATORY & Electrical Hazards - 033
MANDATORY B | |Electrical Hazards - 040
MANDATORY C Electical Hazards - 041
ng‘EAL Electrical Hazards - 042
MPS - BLACK. Electrical Hazards - 043
MPS - BLUE Electrical Hazards - 044

MPS - OUTLINED
PACKAGING & SHIPPING
PEOPLE & OCCUPATIONS

Electrical Hazards - 045
Electrical Hazards - 046
Electrical Hazards - 047

PERMISSION
PERSOMAL PROTECTION Electrical Hazards - 048 B
FHONE & ELECTRONICS | |Electrical Hazards - 049 v

Pictogram Library Browser @

Select a Pictogram

www.stclaire.com
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The edit window will now display the selected pictogram. To preview the updated sign, click on
the 2 Preview Sign button. Now the sign includes the selected header, pictogram and
message. All elements are sized and positioned to best accommodate the available space.

file Edt Preview Took Help
Layout
ae|@=

Message

ISR

=

Arial

‘ Electrical Hazard

Select Pictogram

A DANGER

8 “hste-chCanon iRCA180PS [ 85"by11" | & Edit

B (=1[e3) [

Layout
glg| W ezl -

Preview

&

Electrical
Hazard.

& “hste-chCanon RCS180PS ([ 85'by 11" | Q 26% Preview

EEX

Add Sign Pictogram

Your first sign is now ready for use. All you have to do is print it out.

www.stclaire.com

Page 8



e
[ S%N&If
BUILDER?® Deskiop Edition

4 The Sign Builder DE Interface

The Sign Builder DE interface consists of 5 key areas as follows:

Layout
Message
Header
Pictogram
Preview

aorON~

Safety Sign Burilder
File Edit Preview Tools Help

Safety Sign Builder
File Edt Preview Tools Help

Layout

Layout — — &
Q) deimm w v o o (G| B e w we wie s |

‘Elemrical Hazard |

Header

C |2:z‘GER(ANSLEN) | A DANGER
Pictogram é

G :
Electrical
Hazard.

& Shsto-chCanon RCH180PS |} BE'by 11" | Q 26% Preview

ee=

& “\sto-chCanon iRCETE0PS |[M 85"by 11" | S Edit

Sign Builder DE Interface

4.1 Layout

In the Layout area, Sign Builder DE provides facilities that allow control over sign size,
orientation, overall background color and other associated options. Detailed explanation of each

element is as follows:

Layout

olz|Es B wx wlwe 8
OOG® e ©® ®

Layout Area

1. Print Sign — Prints the sign using the current printer. This option is also available by
selecting File > Print at the main window pulldown menu.

2. Print Setup — Displays the Print Setup window where a printer and associated printer
options can be selected. This option is also available by selecting File > Print Setup at

the main window pulldown menu.

www.stclaire.com Page 9
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3. Preview Sign — Displays the Preview pane where the sign can be viewed and adjusted
prior to printing. This option is also available by selecting Preview at the main window
pulldown menu.

4. Sign Background Color — Displays the Color window where a sign background color
can be selected.

5. Fit Sign to Page — Resets current sign width and height to the maximum size possible
based on the current printer paper size.

6. Sign Width and Height — Allows for setting custom width and height. Values larger than
the maximum width or height supported by the current printer setting will not be
accepted.

7. Units — Toggles width and height units between inches and millimeters.

At startup, Sign Builder DE assigns an initial size to the sign based on the default printer and its
default paper settings. The user can change those settings by using the 8| Print Setup button.
In most cases, a printer will be set to print to a standard Letter (8.5 x 11 inches) sized sheet in
the portrait orientation. The maximum possible sign size for that sheet will then be calculated
and shown, leaving the required margin required by the printer on all four sides of the page.

The sign can always be set to the maximum dimension allotted by the current printer settings
using the | Fit Sign to Page button. The size of the printed sign can also be changed
manually in the Width and Height fields. Note that any entry in these fields must not be greater
than the allowed maximum dimension.

4.2 Message

The Message area is used to edit the sign message and its associated properties. Message
area elements are as follows:

Message

N
00000 @

Message Area

1. Message Font — Displays the Font window where fonts and font properties can be
selected. Font properties can be bold, italic, color, strikeout and underline.

2. Message Background Color — Displays the Color window where a message
background color can be selected.

3. Align Message Left — Aligns the message left.
Center Message — Centers the message.

5. Align Message Right — Aligns the message right.

www.stclaire.com Page 10
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6. Message Font Format And Color - Displays the message font, style, color and
alignment as selected.

7. Sign Message — Input area where the message content can be edited.

Note that selecting font size has no effect on how big the sign message is displayed. Sign
Builder DE automatically resizes and word-wraps the message to maximize the use of the

available space.

In cases where words should remain on the same line, an underscore character “ ” can be used

to indicate a non-breaking space. The effect of non-breaking space is illustrated in the examples

below.

Safety Sign Builder

File Edit Preview Tools Help

Layout

Message

o8 al@m| | [E] ok szl &

(] | E3 Safety Sign Builder
Fle Edt Preview Tools Help

Preview

— & Layout
w@ﬂ% BEEE e

— 4’1‘
EI 53

& \sto-chCanon RCE180PS ([ 11"by 85" | Q Edit

| @ =)= = Arial Bold
JD\J Not Operate Machine Without Guards In Place, |
Header Y
|ARRING (O5HA. ER) v m
\
Pictogram
2| i o

Do Not Operate
Machine
Without Guards
In Place

S W\sto-c\Canon RCGTE0PS | [0 11"byBE" |Q 38% Freview

Message Without Non-Breaking Space

Safety Sign Builder
File Edit Preview Tools Help

(] | E3 Safety Sign Builder
Fle Edt Preview Tools Help

oa|

Preview

:;

& \sto-chCanon RCE180PS ([ 11"by 85" | Q Edit

Layout — 4’[‘ Layout
o8| B 0[St Bﬁﬂf@mﬁ

Message
| @ =)= = Arial Bold
iDﬂiNﬂLOpEralB Machine_Without GuﬂldSJn,PlﬂEE’

Header Y
[WARNING (0SHA EN) v m

\

Pictogram
i i oL
®

[ o &

Do Not Operate
Machine Without
Guards In Place

S W\sto-c\Canon RCGTE0PS | [0 11"byBE" |Q 38% Freview

Message With Non-Breaking Space

The Bl Message Background Color button allows selection of background color for only the
message area of the sign while leaving all remaining sign components with default white
background or as selected by the = Sign Background Color button found in the Layout area.

www.stclaire.com
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The 2| Message Background Color button in combination with the L) Message Font button
make it possible to produce many ANSI and ISO compliant signs that require a colored
message area.

ADANGER

Unauthorised

Electrical
hazard

persons not to
Wear gloves use this machine

Examples of Signs Using a Colored Message Area

4.3 Header

Sign Builder DE includes a number of ANSI, ISO, OSHA and other general-purpose headers
(also known as signal words). The Header area is used to select an appropriate header for
inclusion on your sign. Elements of the Header area are as follows:

Header
ANSI v
DANGER [ANSLEN) v A DAN G E R @

Header Area

1. Header Category — Provides a list of header category options. Selecting a category
limits the number of headers to that category. Categories are ALL, OSHA, ANSI, ISO,
ENGLISH, SPANISH and FRENCH. For example, if the ANSI category is selected, only
ANSI headers will be listed.

Select Sign Header — Provides a list of available sign headers.

Sign Header — Displays a preview of the selected header.

A complete catalog of available headers is provided in Appendix B.
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44 Pictogram

In order to provide visual clues associated with the message, a sign may include a pictogram or
a symbol. Sign Builder DE allows up to two pictograms to be included on a single sign.
Depending on the orientation of a sign, landscape vs. portrait, the pictograms can be positioned
left and/or right or above and/or below of the sign message. Below are various examples of
pictogram positioning using one or two pictograms per sign.

“DANGER"
480 | €=EXIT=)
VOLTS

HIGH VOLTAGE
——

=

Examples of Pictogram Positioning

Explanation of each Pictogram area element is as follows:

Pictogram
(s)

(2
\ J J
Y Y
Left / Top Pictogram Right / Bottom Pictogram

Pictogram Area

1. Select Left/Top Pictogram From Library — Displays the Pictogram Library Browser
window where a pictogram can be selected from the pictogram library for inclusion to the
left or above the sign message.

2. Import Left/Top Pictogram — Displays the Open window where an external pictogram
image from your personal files can be imported for inclusion to the left or above the sign
message.

Clear Left/Top Pictogram — Clears the left/top pictogram preview.
Left/Top Pictogram — Displays a preview of the left/top pictogram.

Select Right/Bottom Pictogram From Library — Displays the Pictogram Library
Browser window where a pictogram can be selected from the pictogram library for
inclusion to the right or below the sign message.
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6. Import Right/Bottom Pictogram — Displays the Open window where an external
pictogram image from your personal files can be imported for inclusion to the right or
below the sign message.

Clear Right/Bottom Pictogram — Clears the right/bottom pictogram preview.

Right/Bottom Pictogram — Displays a preview of the right/bottom pictogram.

The Sign Builder DE library contains in excess of 6000 scaleable vector pictograms. A complete
catalog is provided in Appendix C. Pictograms contained in the library can be selected using the
Pictogram Library Browser window. The elements of the Pictogram Library Browser windows
are as follows:

Libraries — Lists all available pictogram library titles.

Pictograms — Lists all pictograms contained within the currently selected library title.
Pictogram Preview — Displays the currently selected pictogram.

Use — Imports the currently selected pictogram for use.

Cancel — Exits the Pictogram Library Browser.

ok wnd -~

Pictogram Library Browser

Libraries: Pictograms:
1 ﬁg:gwg gtﬁgk @ Electical Hazards - 018 @
RS e s s 2
ARROWS GREEN
ARROWS OUTLINED Electrical Hazards - 022
ﬁaﬁ%\eﬁ&? Electrical Hazards - 023
Electrical Hazards - 024
EEEAWSLHJAZAHDS Electrical Hazards - 025
DANGER Electrical Hazards - 026
DOT HAZARDS A Electrical Hazards - 027
"“"“F‘D" Electrical Hazards - 028
EMERGENCY PREFAREDNESS Electical Hazards - 029
FIRE CONTROL A Electrical Hazards - 030
FIRE CONTROL B Electrical Hazards - 031
ﬂ;ﬁg??ﬁn Electrical Hazards - 132
HOUSEKEEPING & RECYCLING Electical Hazerds - 033
INDUSTRIAL Electrical Hazards - 034
INFORMATIONAL - BLUE Electrical Hazards - 035
:-NUJEUKF!UYUF;ATZ:&IIJST Electrical Hazards - 036
LOBEINE £ TAAVELING Soonlfacar - 0
MANDATORY & Electrical Hazards - 039
MANDATORY B Electrical Hazards - 040 @ @
MANDATORY C Electrical Hazards - 041
mgg\mL Electrical Hazards - 042
NPS - BLACK. Electrical Hazards - 043
MPS - BLUE Electrical Hazards - 044
g;’g@UEL\IrEEr:i‘[:IIPPINE Electtical Hazards - 045
EOPLE & DEPATIONS Elecnied Horardi 047
PERMISSION
PERSOMAL PROTECTION Electrical Hazards - 048
PHONE & ELECTRONICS | |Electrical Hazards - 049 b

Pictogram Library Browser Window

Although it is an extensive resource, the pictogram library may not always provide suitable
content for unique or obscure situations. To accommodate such cases, Sign Builder DE can
also import user-supplied external images or pictograms. Supported file formats are as follows:

WMF — Windows Metafile

EMF - Extended (Enhanced) Windows Metafile
BMP — Windows OS/2 Bitmap

DIB — Device-Independent Bitmap

JPG — JPEG/JFIF Image

GIF — Graphic Interchange Format
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4.5 Preview

The preview area displays an approximate representation of the final sign, as it will appear
when printed. To display the Preview pane from the main edit window, use the B/ Preview Sign
button. With the Preview pane displayed, you'll notice that the B/ Preview Sign button in the
layout area is now replaced with the &/ Edit Sign button. Elements of the preview area are as
follows:

Preview

Electrical
Hazard.

Preview Area

1. Adjust Message/Pictogram Ratio — Adjusts the size of the sign message and
pictograms differentially.

2. Preview Pane — Displays an approximate representation of the final sign.

Moving the Adjust Message/Pictogram Ratio slider up increases the size of the pictograms
while decreasing the size of the message. Respectively, moving the Adjust Message/
Pictogram Ratio slider down decreases the size of the pictograms while increasing the size of
the message. An example is shown below:

Safety Sign Builder M[=1E3 Safety Sign Builder
File Edt Preview Tools Help Fle Edit Preview Tools Help

Layout
EIEI @ ﬂx\nches @

Preview

/\CAUTION ACAUTION

Invisible laser radiation
when open & interlock
[ > failed or defeated Avoid
eye or skin exposure to
direct or scattered
radiation

|© Wste-c\Canon RC5180PS [0 85" bp 11" |Q 29% Preview /| |8 Wste-c\Canon RC5180PS |[) B5"bp 11" [Q 29% Previem |

Relative Sizing of Pictogram and Message
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5 Creating Compliant Industrial Safety Signs

Signs developed to be in compliance with one of the applicable safety standards need to follow
guidelines established for that specific standard. General guidelines for each applicable
standard are outlined within this manual. Standards and Regulations covering industrial safety
signage can be acquired from the following:

o ANSI (American National Standards Institute — www.ansi.org)
¢ ISO (International Organization for Standardization — www.iso.org)
e OSHA (Occupational Safety and Health Administration — www.osha.gov)

5.1  ANSI Z2535.4-2002 Compliant Safety Signs

ANSI Z535.2-2002 specifies the current standard for safety signs. A variance from the older
1998 standard, ANSI Z535.2-2002 signs are made up of three distinct panels or areas within the
sign. Understanding all the conditions and likelihood of injuries should be the first consideration
when creating a safety sign.

The first panel is the header panel that contains the Signal Words DANGER, WARNING,
CAUTION or NOTICE. When using these symbol words or headers (exception Notice), the
safety alert symbol 4 should be used in conjunction with the signal word. Examples built using
Sign Builder DE are shown below.

VUL [e]Sy| «—— HeaderPanel —— [ 4, CAUTION

<4— Pijctorial Panel ——»

Hazardous voltage.
BIELL L 8T «—  Message Panel
before servicing.

Safety gloves

required.

Typical ANSI Compliant Signs

5.1.1 ANSI Style Header Panel
The following are standard headers identified by ANSI Z535.2-2002.

DANGER: Indicates an imminently hazardous situation that, if
A DANGER not avoided, will result in death or serious injury. Safety Signs

identified by the signal word DANGER should be used sparingly
and only for situations presenting the most serious hazards.
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WARNING: Indicates a potentially hazardous situation that, if
AWARNING not avoided, will result in death or serious injury. Hazards
identified by the signal word WARNING present a lesser degree
of risk of injury or death than those identified by the signal word

DANGER.

CAUTION: Indicates a potentially hazardous situation that, if not
&CAUTION avoided, may result in minor or moderate injury. It may also be

used to alert against unsafe practices associated with events
that could lead to personal injury.

NOTICE: Indicates a statement of company policy directly or
N o ' ’ CE indirectly related to the safety of personnel or protection of
property. This signal word should not be associated directly with

hazard or hazardous situations and shall not be used in place of
danger, warning or caution.

5.1.2 ANSI Style Pictorial Panel

The second panel is the pictorial panel that contains a symbol appropriate to the hazardous
information you are trying to convey. There are two different classifications of pictorials:

Hazard Alerting Pictorials — a picture (as shown below) that shows what the hazard is
and what the consequences are if the worker fails to follow the instructions.

& & AN B

Hazard Avoidance Pictorials — a picture (as shown below) that illustrates the action to
be taken to avoid the hazard.

8
3 i &8 & K
5.1.3 ANSI Style Message Panel

ANSI| recommends a combination of UPPERCASE and lowercase sans serif text when writing
messages in the sign.

Uppercase text should be used to call to action, a consequence statement, emergency
information or to describe the hazard that is present.

Lowercase text should be used to give instructions about how to avoid the hazard, to
outline the consequences more in detail, to explain the action statement or outline safety
measures to be taken.
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5.2 1SO 3864-2-2004 Compliant Safety Signs

Along with the ability to create ANSI style signs, Sign Builder DE offers the ability to create 1ISO
style signs. ISO 3864 builds on the system of hazard communication in identifying the severity
level of the hazard and supplementary safety information in word or symbolic form that aids in
the communication of safety information across language barriers. Safety signs that include text
can be used when some of the necessary safety information cannot be communicated in
symbolic form, when the combination of safety sign with text is judged to be more effective or
when legal requirements in countries mandate the use of text to communicate safety
information.

Typical examples of ISO 3864 compliant signs built using Sign Builder DE are shown below.

/N\CAUTION A DANGER

% Standard I1SO style
< Signs utilizing S|gnal_>

word, safety symbol

D9 not operate ‘ and information text. Do not touch
without guards in .
place. loose wires.

. Landscape ISO style
Eye Protection must | sion without header,

be worn in this area. ‘S‘:jgfg)g?_ a Mandatory

Typical ISO Compliant Signs

5.2.1 ISO Style Header Panel

Similar to ANSI headers, ISO headers or the “hazard severity panel” includes a general warning
symbol. In contrast to the ANSI general warning symbol, ISO shows a yellow background with a
black explanation mark A\,

The following are standard ISO headers.

DANGER indicates a hazard with a high level of risk that, if not
A DAN GE R avoided, will result in death or serious injury.

www.stclaire.com Page 18
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WARNING indicates a hazard with a medium level of risk that, if
&WARN I NG not avoided, could result in death or serious injury.

CAUTION indicates a hazard with a low level of risk that, if not
&CAUTI ON avoided, could result in minor or moderate injury.

5.2.2 ISO Style Pictorial Panel

ISO compliant pictograms use shape and color to communicate. Geometric surround shapes
and their respective meanings are listed below:

WARNING - A black graphical symbol inside a yellow triangle with a black triangular
band defines a safety sign that indicates a hazard.

diagonal bar defines a safety sign that indicates that an action shall not be taken or

\u shall be stopped.
< E >¢| ‘. _
‘\_)/ A

MANDATORY - A white graphical symbol inside a blue circle defines a safety sign
that indicates that an action shall be taken to avoid a hazard.

® PROHIBITION - A black graphical symbol inside a red circular band with a red
l
y

5.2.3 ISO Style Message Panel

ISO message panel recommendations are very similar to ANSI. One exception worth noting is
that it is acceptable to emphasize the message by using color as follows:

o WARNING - Black text on Yellow background
PROHIBITION — White text on Red background
o MANDATORY — White text on Blue background
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5.3

OSHA 1910.145 Compliant Safety Signs

This specification applies to the design, application and use of signs or symbols intended to
indicate and, insofar as possible, to define specific hazards of a nature such that failure to
designate them may lead to accidental injury to workers or the public, or both, or to property
damage. This specification is intended to cover all safety signs except those designed for
streets, highways, railroads, and marine regulations. Typical examples of OSHA 1910.145
compliant signs built using Sign Builder DE are shown below.

DANGER>

AUTHORIZED ==
%
PERSONNEL m;w;

ONLY
WATCH )z\’

YOUR
STEP »le=m

OSHA style sign using
Danger header with
hazard symbol on the
right side of sign.

OSHA style sign using
Warning header with
hazard symbol on the
right side of sign

CAUTION

FORKLIFT
TRAFFIC
KEEP
o™, CLEAR

EMERGENCY
EYE WASH

K

Typical OSHA Compliant Signs

5.3.1 OSHA Style Header Panel

OSHA style sign using
Caution header with
hazard symbol on the
left side of sign.

OSHA style sign using
Safety First header with
hazard symbol on the
right side of sign.

The header definitions seem very similar between ANSI, ISO and OSHA yet, to some, contain
important differences regarding the probability of serious death or injury. The OSHA header
definitions are as follows:

DA:IEG:ER

CAUTION

DANGER shall be used in major hazard situations where an
immediate hazard presents a threat of death or serious injury to
employees. Danger tags shall be used only in these situations.

WARNING may be used to represent a hazard level between
"Caution" and "Danger,".

CAUTION shall be used in minor hazard situations where a
non-immediate or potential hazard or unsafe practice presents a
lesser threat of employee injury.

www.stclaire.com
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5.3.2 OSHA Style Pictorial Panel

OSHA compliant safety signs may contain a pictogram alongside the sign message. Generally,
it is acceptable to use ANSI or ISO compliant pictograms in OSHA compliant signs.

5.3.3 OSHA Style Message Panel

OSHA compliant signs use centered, all caps message text.

5.4 Use of Color

When creating safety signs there are five basic colors that are commonly used, usually in
conjunction with signal words or hazard classification.

RED is used to identify hazards that are immediate and have the potential for
serious injury or death. Red is commonly used with Danger, Fire or Stop
situations. This is usually used to label flammable liquids, emergency switches
and fire issues.

ORANGE is used to identify hazards that are serious but not necessarily
immediate. It warns the reader to be careful because there is the potential for
serious injury or even death. Examples would include pinch points, machinery
and moving parts. Orange is most commonly used with the signal word
Warning.

YELLOW is used to identify hazards that might result in injury that, while not
necessarily life threatening, could still be somewhat serious. Slips, trips and falls
would fall into this category as would certain storage cabinets (corrosives,
flammabiles, etc...). Caution is most commonly used with the color yellow.

GREEN identifies safety and is usually used to identify safety material like
MSDS sheets, first aid and medical. There is no immediate danger present. It is
typically associated with the word “Safety” or “Think”.

BLUE is most often used with signs requiring use of personal protective
equipment, safety regulations and procedures. Blue is most commonly used
with the signal word “Notice”.

5.5 Safety Symbols and Pictograms

The use of descriptive safety symbols and pictograms is an important part of industrial safety
communication. Sign Builder DE provides an extensive library of ANSI, ISO and OSHA
symbols. In addition, included are shipping & handling, egress & assembly, housekeeping &
recycling, DOT Identification, lockout/tagout, medical, industrial and a host of other general
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purpose symbols. For a complete catalog of available Sign Builder DE Symbols, see
Appendix C

5.6 Safety Sigh Message Viewing Distance

Determining the safe viewing distance of a sign depends upon many factors, including lighting,
background, letter type and visual acuity. The ANSI Z535-2002 standard uses a ratio of 25 feet
of viewing distance per inch of text (character height) for favorable reading conditions and a
ratio of 12 feet of viewing distance per inch for unfavorable reading conditions. Other factors to
consider in determining signage size, include: the complexity of the message, an individual’s
reaction time necessary and the angle the sign will be seen from. In many situations it is better
to use multiple smaller signs that are strategically positioned instead of one large sign. Many
times letter size may need to be larger for a variety of reasons:

To make the label more noticeable from other information displayed in the area
To enable legibility under low light, or other poor viewing conditions

To alert personnel sooner than the minimum safe viewing distance

To convey special importance for portions of the message

To improve legibility for persons who have vision problems with small text

www.stclaire.com Page 22



l IGN& _
BUILDERY Deskion Edition

6 Creating General Purpose Signs

Sign Builder DE can be used to build a variety of signs for general or recreational purposes
where adhering to a regulation or a standard is not necessary. Coupled with the ability to import
custom user-supplied images, signs for various occasions are simple to create and limited only
by your imagination. Some examples of such signs are shown below.

Congratulations P
On Your o E N
Promotion John 'l Monday - Friday
o o || Weliome 8AM - 5PM
p , e Saturday - Sunday
VNS || Back Goka | 77 q0AM - 3PM

ﬂ RESTROOMS ﬂ Be Quiet! )t
“ﬂ DOGS ALLOWED \~

YOU GO
WILDGATS

GLEANIT UP!

FOR SALE

3 Fully Restored and
. Ready to Drive
Call 123-456-7890

e

W
:: ot BIrWa7 4044: :.: -

P

Examples of General Purpose Signs
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Appendix A: Sign Examples

After a brief exposure to Sign Builder DE you’ll notice that the interface is very intuitive and the
overall behavior of the tool is very predictable. We'd encourage you to experiment with various
combinations in order to become comfortable with the relationship of the interface elements and
the components of a sign as presented by the preview. Below provided are a number of
practical examples illustrating the capabilities of Sign Builder DE. To build the signs shown in
the examples, simply replicate the state of the Layout, Message, Header and Pictogram areas
as illustrated in the example screens.

Safety Sipn Builder

Safety Sign Builder
File Edit Preview Tools Help

File Edit Prewiew Toadls Help

Layout _(‘ Layout _{’
ofs| Eell el ox 0w af Bwaf@m“.ﬂg EEREET m@%m“.ﬂa
Message Preview
| B == :
|RESERVED PARKING ‘
Header
-
|~ NO HEADER - ~| :
Pictogram
RESERVED
PARKING
& “ate-c\Canon RCE180PS [ 85'by 11" Qs Edit & Yhate-c\Canon RCE180PS |0 85"by 11" Qs 26% Preview

Safety Sign Builder Safety Sign Builder,
File Edit Preview Tools Help File Edit Preview Tools Help
Layout _{‘ Layout _Q
i B8 82 10.7| Inch S ) §.2 107 Inch S S
oz = om edx ohes | ILBE-R olg[Fm @l sex[ 1orfiee g m@f@m..*g
Message Preview
| 2| =| =] = Arial Bold
|STUDENT CROSSWALK :
Header
pa—t
[CAUTION (OSHA INV.EN) ~| CAU T I O N
Pictogram
STUDENT
CROSSWALK
& “ate-c\Canon ACS180PS [ 85'by 11" Qs Edit & “ate-c\Canon RCS180PS [ 85"bw 11" | 26% Preview
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Safety Sign Builder

Safety Sign Builder

Elle Edit Preview TIoals Help

Eile Edit Preview Tools Help
Layout —
als| Ea w0k e o [CHEES
BUILDER
Message
NEEEE
|HIGH VOLTAGE
Header
‘WARNING (0SHA EM) v|
Pictogram
& Miste-chCanon RC5180PS | [y 11"bp&5" G Edit

Layout
SE

Praview

k[ ez @&

HIGH
VOLTAGE

& Miste-chCanon RCS180PS [y 11"bw 85" Q 34% Preview

)

Safety Sign Builder
File Edit Preview Tools Help

Layout =
glg|ElsE @ cox owe s [B@@Q

Message
| & =] = 4|

|Keep guards in place ‘

S A DANGER

Header

| DANGER (ANSI, FR)

Pictogram

C Edit

S Yhste-cMCanon ACST80PS |[h 8.5 by 11"

afety Sipn Builder

File Edit Prewiew Toadls Help

Layout
SR o2 07 e
Preview

A DANGER

Keep guards
in place

& Yhate-c\Canon RCE180PS |0 85"by 11" Qs 26% Preview

Safety Sign Builder

Fie Edt Preview Tnoks

Help

Layout

ole|Ee @l x| o a

Arial Bold

Message

s
o= ===

|AUTHORIZED PERSONNEL ONLY \

Header

E =l NOTICE
Pictogram
B |

& “ate-c\Canon ACS180PS [ 11" bw8S5" Qs Edit

afety Sipn Builder

Edit Preview Tools Help

ola|@s @l 0w af m@gj

Preview

AUTHORIZED

PERSONNEL
ONLY

& “ate-c\Canon RCS180PS |0 11" bw85" | 34% Preview
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Safety Sign Builder
Eile Edit Preview Tools Help

Layout
B8le|He
Message

NELEE

Safety Sign Builder,
Elle Edit Preview TIoals Help

S8 @

Praview

Y
SIGN a,-
gl BUILDER(,

Arial Bold

|FOR SAFETY

Header

|~ NOHEADER - v

Pictogram

2 Mo c\Canon ACGTE0FS [ BS'by 11 O Edi /|

ez 07 @&

SIGN|
BUILDER(

Safety Sign Builder
File Edit Preview Tools Help

Layout

Message

INEIEEE

ole|Ee @l x|

Safety Sign Builder,
File Edit Prewiew Toadls Help

Layout
Blal

Preview

|RESTRO0MS

Header

|~ NO HEADER - v

Pictogram

SIGN|
El BUILDE

RESTROOMS B

| “hstoc\Canon ACS1B0PS [ 14"by 85" |Q Edit A

| Whstoc\Canon ACSTB0PS [ 14"by 85" | 34% Preview A

Safety Sign Builder
File Edit Preview Tools Help

Layout

FEEE
Message
NEEEE

Safety Sign Builder
Ele Edit Preview Tools Help

Layout

SIGN 2

o S8 g
Preview

|D|:| Not Use Mobile Phones

Header

|~ NOHEADER. -

Pictogram

|

/& wste-c\Canon ACS180PS () 85 by 11" | Qs Edit A

SIGN,
El BUILDE

Do Not Use
Mobile Phones

/& wste-c\Canon RCS180PS | 85" by 11" [Q 26% Preview A
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Safety Sign Builder - For Sale - F150 - landscape.ssh

Eile Edit Preview Tools Help

Layout
ola e o erx e |
Message

N

Arial Narrow

Elle Edit Preview TIoals Help
Layout
Llg|

Praview

|2l]l]?7F—l 50 LIKE_NEW ONLY_13,050_MILES PRICED_TO_SELL $25.600.00

FOR SALE

Safety Sign Builder, - For Sale - F150 - landscape.ssh

Tk e &

FOR SALE

Header
|~ NOHEADER - ~|
Pictogram

& Vsloo\Canon ACEEDFS |0 17" by 11 (G Edi /]

2007 F-150
LIKE NEW
ONLY 13,050 MILES
PRICED TO SELL
$25,600.00

Safety Sign Builder - T
File Edit Preview Tools Help

Layout

ole|@= @l x|

File Edit Prewiew Toadls Help
Layout

Preview

|SAFETY IS NO ACCIDENT

Header

|~ NO HEADER - v

Pictogram

&

/& Wate-chCanon iACSIBOPS [ 11" by 17" | Q Edit A

ﬁlx Inches gl

SAFETYISNO
ACCIDENT

/& Wate-c\Canon iACSIBIPS [ 11"by 17" |Q 17% Preview A

Safety Sign Builder - FIRE EXTINGUISHER.ssb

Fie Edt Preview Tnok Help

Ealyngml ] e

Message

NS

af

=|=| T

File Edit Preview Tools Help
Layout

Preview

|FIRE EXTINGUISHER

Header

|~ NOHEADER. - v

Pictogram

B

-@-

& Vste-chCanoniRCS1B0PS [ 11"by 17" | Edit A

n Builder - FIRE EXTINGUISHER.ssb

. ﬁlﬂxﬂmmes gl

FIRE
EXTINGUISHER

| Wste-c\Canon iRCHIB0PS [0 11" by 17" % 17% Preview A
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Safety Sign Builder - Ansi - Emergency.ssh
Eile Edit Preview Tools Help Elle Edit Preview TIoals Help
— Layout A
SHEEE Y (SICN
BUILDER: JJ J J BUILDER:

Layout
%g E ﬂxh’\ches @

af 8 == S —

|Emergency shower. Keep area clean.

Header

|~ NOHEADER -

Praview

Emergency
: shower. Keep
area clean.

Pictogram

& Miste-chCanon RC5180PS [y 85"by 11" Q4 26% Preview

& Miste-chCanon RC5180PS | [y 85"by 11" |G Edit

YE_PROTECTION_MUST BE IN_THIS_AREA.ssh

. T BE_WORN_IN_THIS_AREA.ssh

File Edit Preview Tools Help File Edit Preview Tools Help

Layout — Layout _—

o B (2 e @ 2k 3]k =3 S o8 e [IRELE T S
elel E= & e | BUILDER ||| &lel = & BUILDER ;

Message
Arial Narrow

SR

| EYE_PROTECTION_MUST BE_WORN_IN_THIS_AREA

4 EYE PROTECTION MUST
BE WORN IN THIS AREA

\—NOHEADER -

Preview

Pictogram

& Miste-chCanon RCS180PS [y 14"bw 85" Q. 33% Preview

& Whste-chCanon iRCS180 PS |[Y 14" by 85" G, Edit

Safety Sign Builder - 1S0.ssh

Safety Sign Builder - 1S0.s5h %]
File Edit Preview Toaols Help File Edit Prewiew Toadls Help
. Layout N
| @ SIHEE | SICN
BUILDER JJ J J J BUILDER

Layout
ole| e m ex[ swe el
Preview

Message
o/ ) -/ E——C—

|EYE AND HEARING FPROTECTION REQUIRED

Header :
|~ NOHEADER.— v F Y EYE AND HEARING
' ' PROTECTION
Pictogram REQUIRED

' | Q, 33% Preview

& “hste-cMCanon RCETE0PS | [ 14" by 85"

' Q Edit

& Mste-c\Canon iRCS1B0PS | [ 14" by 85'
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Appendix B: Header Reference

The following is an illustrated reference of all headers (signal words) made available by Sign

Builder DE. Updated libraries containing additional headers may be available. Check the Sign
Builder DE website (http://www.stclaire.com/sign_builder/) for availability.

STANDARD HEADERS

ABIERTO

ABIERTO (ES)

ADVIERFENCIA

A\ ADVERTENCIA

ADVERTENCIA (ALT, ES)

ADVERTENCIA (ANSI, ES)

A\ ADVERTENCIA

ADVERTENCIA (ANSI, INV, ES)

/\ ADVERTENCIA

ADVERTENCIA (ISO, ES)

ADVERTENCIA

ADVERTENCIA (OSHA, ES)

AREA
RESTRINGIDA

AREA RESTRINGIDA (ES)

ATFENTION

A\ATTENTION

ATTENTION (ALT, FR)

ATTENTION (ANSI, FR)

A\ATTENTION

ATTENTION (ANSI, INV, FR)

/\ATTENTION

ATTENTION

ATTENTION (ISO, FR)

ATTENTION (OSHA, FR)

ATTENTION (OSHA, INV, FR)

4. ATTENTION

ATTENTION (RADIATION, FR)

4.*ATTENTION

ATTENTION (RADIATION, INV, FR)

A\ AVERTISSEMENT

AVERTISSEMENT (ALT, FR)

AVERTISSEMENT (ANSI, FR)

A\ AVERTISSEMENT

AVERTISSEMENT (ANSI, INV, FR)

/I\ AVERTISSEMENT

AVERTISSEMENT (ISO, FR)

AVERTISSEMENT (OSHA, FR)

AVISO

AVISO (ES)
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STANDARD HEADERS

E CAREFUL (EN)

E

CAUT IO

CCCCCCC (ALT, EN)

ACAUTION

CAl
ION (

ACAUTION

CAUTIO

CCCCCCC (OSHA, EN)

CAUTION (OSHA, I

CAUTION

“ CAUTION

“:* CAUTION

CCCCCCC (RADIATION, INV, EN)

CLOSED

CCCCCC (EN)

CUIDADO

CUIDADO (ALT, E

ACUIDADO

DDDDDDD (ANSI, ES)

DDDDDDD (ANSI, INV, ES)

/\CUIDADO

DDDDDDD (IS0, ES)

CUIDADO (OSHA, ES)

CUIDADO (OSHA,

, INV, ES)

44 CUIDADO
CUIDADO (RADIATION, ES

)

o I
c

+.4 CUIDADO
IDADO (RADIATION, INV, ES)

DANGER

DDDDDD (ALT, EN) DA :
DANGER (ANSI, EN)

DDDDDD (ISO, EN)

A DANG

DDDDDD (IS0, FR)

DANGER
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STANDARD HEADERS

EMERGENCIA

EEEEEEEEEE (ES)

EMERGENCY

EEEEEEEEE (EN)

EN VENTE

EXIT

EXIT (EN)

FAl ON (FR)

IRST AID (EN)

FOR SALE

IT ATTENTI

EEEEEEE (EN)

!

K U

D REMIEREMEN

EEEEEEEEEEEEEEEEEEEE (FR)

NO ENTRAR

NO ENTRAR (ES)

NO ESTACIONAR

NNNNNNNNNNNN (ES)

NO EXIT (EN)

NO HAY SALIDA

DA (ES)

NO PARKING

NOTIFICATION

PIENSE CALIDAD (ES)

POR FAVOR
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STANDARD HEADERS
YN (39wl 4R 4\ PRECAUCION
PRECAUCION (ALT, ES) PRECAUCION (ANSI, ES) PRECAUCION (ANSI, INV, ES)
/N\PRECAUCION | PRECAUCION| | [i{=(%:UIn[o]}
PRECAUCION (ISO, ES) PRECAUCION (OSHA, ES) PRECAUCION (OSHA, INV, ES)
RESTRICTED
PRIMEROS AUXILIOS (ES) REN) SAFETY FIRST (EN)
SALIDA
SALIDA (ES) SEA CUIDADOSO (ES) SEGURIDAD PRIMERO (ES)
THINK (EN) THINK QUALITY (EN) URGENCE (FR)
WARNING AWARNING p!N LU e
WARNING (ALT, EN) r WARNING (ANSI, EN) WARNING (ANSI, INV, EN)
L WARNING
WARNING (ISO, EN) WARNING (OSHA, EN)
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Appendix C: Pictogram Reference

Sign Builder DE ships with over 6000 pictograms and symbols primarily for use with safety
signage. All pictograms are organized in topical libraries. The following is an illustrated
reference of all available pictograms. Updated libraries containing additional pictograms may be
available. Check the Sign Builder DE website (http://www.stclaire.com/sign_builder/) for
availability.

ARROWS BLACK

<
p

v

ARROW 000

ARROW 001

ARROW 002

ARROW 003

4
)

ARROW 004

ARROW 005

ARROW 006

A

ARROW 007

4
L\
3
”
€

>
\

()

ARROW 008

ARROW 009

ARROW 010

ARROW 011

ARROW 012

ARROW 013

ARROW 014

ARROW 015

4
N
N
7
e

>
4

()

ARROW 016

ARROW 017

ARROW 018

ARROW 019

ARROW 020

ARROW 021

ARROW 022

ARROW 023

V4
N
A\
/)
é

BN
v

4\

ARROW 024

ARROW 025

ARROW 026

ARROW 027

ARROW 028

ARROW 029

ARROW 030

ARROW 031

-
-
-
p—

)
)

(
t

ARROW 032 ARROW 033 ARROW 034 ARROW 035 ARROW 036 ARROW 037 ARROW 038 ARROW 039
ARROW 040 ARROW 041 ARROW 042 ARROW 043 ARROW 044 ARROW 045 ARROW 046 ARROW 047

¢
"

D

ARROW 048

ARROW 049

ARROW 050

-
-«
)4

ARROW 051

ARROW 052

ARROW 053

¥
'.

ARROW 054

ARROW 055
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ARROWS BLACK

249> D E e

ARROW 056 ARROW 057 ARROW 058 ARROW 059 ARROW 060 ARROW 061 ARROW 062 ARROW 063
—) | ) | | —) | —

ARROW 064 ARROW 069 ARROW 070 ARROW 071 ARROW 072 ARROW 073 ARROW 074 ARROW 075

ARROW 076 ARROW 077 ARROW 078 ARROW 079 ARROW 080 ARROW 081 ARROW 082 ARROW 083
lT***é**

ARROW 084 ARROW 085 ARROW 086 ARROW 087 ARROW 088 ARROW 089 ARROW 090 ARROW 091
*T**lT**

ARROW 092 ARROW 093 ARROW 094 ARROW 095 ARROW 096 ARROW 097 ARROW 098 ARROW 099

ARROW 100 ARROW 101 ARROW 102 ARROW 103 ARROW 104 ARROW 105 ARROW 106 ARROW 107

VAVA}{

ARROW 108 ARROW 109 ARROW 110 ARROW 111 ARROW 112 ARROW 114 ARROW 115 ARROW 116

‘kDQ»‘

ARROW 117 ARROW 118 ARROW 119 ARROW 120 ARROW 121 ARROW 122 ARROW 123 ARROW 124

ARROW 125 ARROW 126 ARROW 127 ARROW 128 ARROW 129 ARROW 130 ARROW 131 ARROW 132
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ARROW 133 ARROW 134 ARROW 135 ARROW 136 ARROW 137 ARROW 138 ARROW 139 ARROW 140
ARROW 141 ARROW 142 ARROW 143 ARROW 144 ARROW 145 ARROW 146 ARROW 147 ARROW 148
.
g W gy /\ |7\
ARROW 149 ARROW 150 ARROW 152 ARROW 153 ARROW 154 ARROW 155 ARROW 156 ARROW 157
ARROW 158 ARROW 159 ARROW 160 ARROW 161 ARROW 163 ARROW 164 ARROW 165 ARROW 166
—
—

ARROW 167 ARROW 168 ARROW 169 ARROW 170 ARROW 171 ARROW 172 ARROW 173 ARROW 174
ARROW 175 ARROW 176 ARROW 177 ARROW 178 ARROW 179 ARROW 180 ARROW 181 ARROW 182

|

|

| B mEEm * * EEm

.

‘ |

ARROW 183 ARROW 184 ARROW 185 ARROW 186 ARROW 187 ARROW 188 ARROW 189 ARROW 190
i ‘ — —

ARROW 191 ARROW 192 ARROW 193 ARROW 194 ARROW 195 ARROW 196 ARROW 197 ARROW 198
ARROW 199 ARROW 200 ARROW 201 ARROW 202 ARROW 203 ARROW 204 ARROW 205 ARROW 206
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ARROWS BLACK

1

ARROW 207

ARROWS BLUE

<
p

v

ARROW 000

ARROW 001

ARROW 002

ARROW 003

\

ARROW 004

ARROW 005

ARROW 006

ARROW 007

4

ARROW 008

ARROW 009

ARROW 010

ARROW 011

ARROW 012

ARROW 013

ARROW 014

ARROW 015

N

ARROW 016

ARROW 017

ARROW 018

ARROW 019

&
4

ARROW 020

ARROW 021

ARROW 022

()

ARROW 023

V4
N
AV
/)
é
9

ARROW 024

ARROW 025

ARROW 026

ARROW 027

ARROW 028

ARROW 029

v
4\

ARROW 030

ARROW 031

-

ARROW 032

ARROW 033

ARROW 034

ARROW 035

)
)

ARROW 036

ARROW 037
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t

ARROW 038

ARROW 039

ARROW 040

ARROW 041

ARROW 042

ARROW 043
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N

ARROW 044

ARROW 045

ARROW 046

s

ARROW 047

¢

ARROW 048

ARROW 049

ARROW 050

ARROW 051
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ARROW 052

ARROW 053

¥
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ARROW 054

ARROW 055
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ARROWS BLUE
29> D E- e
ARROW 056 ARROW 057 ARROW 058 ARROW 059 ARROW 060 ARROW 061 ARROW 062 ARROW 063
— | | | | —) | —
ARROW 064 ARROW 069 ARROW 070 ARROW 071 ARROW 072 ARROW 073 ARROW 074 ARROW 075
ARROW 076 ARROW 077 ARROW 078 ARROW 079 ARROW 080 ARROW 081 ARROW 082 ARROW 083
lT***é**
ARROW 084 ARROW 085 ARROW 086 ARROW 087 ARROW 088 ARROW 089 ARROW 090 ARROW 091
Jv 1‘ —> € l T —> |
ARROW 092 ARROW 093 ARROW 094 ARROW 095 ARROW 096 ARROW 097 ARROW 098 ARROW 099
ARROW 100 ARROW 101 ARROW 102 ARROW 103 ARROW 104 ARROW 105 ARROW 106 ARROW 107
VAV a } {
ARROW 108 ARROW 109 ARROW 110 ARROW 111 ARROW 112 ARROW 114 ARROW 115 ARROW 116
ARROW 117 ARROW 118 ARROW 119 ARROW 120 ARROW 121 ARROW 122 ARROW 123 ARROW 124
ARROW 125 ARROW 126 ARROW 127 ARROW 128 ARROW 129 ARROW 130 ARROW 131 ARROW 132
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ARROW 133 ARROW 134 ARROW 135 ARROW 136 ARROW 137 ARROW 138 ARROW 139 ARROW 140
ARROW 141 ARROW 142 ARROW 143 ARROW 144 ARROW 145 ARROW 146 ARROW 147 ARROW 148
ARROW 149 ARROW 150 ARROW 152 ARROW 156 ARROW 157 ARROW 158 ARROW 159 ARROW 160
ARROW 161 ARROW 162 ARROW 163 ARROW 164 ARROW 165 ARROW 166 ARROW 167 ARROW 168
———
—
ARROW 169 ARROW 170 ARROW 171 ARROW 172 ARROW 173 ARROW 174 ARROW 175 ARROW 176
ARROW 177 ARROW 178 ARROW 179 ARROW 180 ARROW 181 ARROW 182 ARROW 183 ARROW 184
[ |
[ |
O B EEE * * EEEm H
.
‘ [ |
ARROW 185 ARROW 186 ARROW 187 ARROW 188 ARROW 189 ARROW 190 ARROW 191 ARROW 192
- —
‘ —— ———
ARROW 193 ARROW 194 ARROW 195 ARROW 196 ARROW 197 ARROW 198 ARROW 199 ARROW 200
ARROW 201 ARROW 202 ARROW 203 ARROW 204 ARROW 205 ARROW 206 ARROW 207
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Arrows -
General - 001

L2
N
()

Arrows -
General - 002

Arrows -
General - 003

Arrows -
General - 004

Arrows -
General - 005

'
N
3

Arrows -
General - 006

Arrows -
General - 007

Arrows -
General - 008

&
€
©
Yy
©
©

)

Arrows -
General - 009

Arrows -
General - 010

Arrows -
General - 011

Arrows -
General - 012

Arrows -
General - 013

Arrows -
General - 014

Arrows -
General - 015

Arrows -
General - 016

©
)
©
©
©
@
©

Arrows -
General - 017

Arrows -
General - 018

Arrows -
General - 019

Arrows -
General - 020

Arrows -
General - 021

Arrows -
General - 022

Arrows -
General - 023

Arrows -
General - 024

2

Arrows -
General - 025

Arrows -
General - 026

Arrows -
General - 027

0
8

N
2
Q

Arrows -
General - 028

Arrows -
General - 029

Arrows -
General - 030

Arrows -
General - 031

Arrows -
General - 032

O

Arrows -
General - 033

\

Arrows -
General - 034

Arrows -
General - 035

Y
\

Arrows -
General - 036

Arrows -
General - 037

!

"
>

Arrows -
General - 038

Arrows -
General - 039

Arrows -
General - 040

“\

!

I
{

V
\Y%

\

Y

Arrows - Arrows - Arrows - Arrows - Arrows - Arrows - Arrows - Arrows -
General - 041 General - 042 General - 043 General - 044 General - 045 General - 046 General - 047 General - 048
Arrows - Arrows - Arrows - Arrows - Arrows - Arrows - Arrows - Arrows -
General - 049 General - 050 General - 051 General - 052 General - 053 General - 054 General - 055 General - 056
Arrows - Arrows - Arrows - Arrows - Arrows - Arrows - Arrows - Arrows -
General - 057 General - 058 General - 059 General - 060 General - 061 General - 062 General - 063 General - 064
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ARROWS GENERAL

Y

—

<>

>

l

Arrows - Arrows - Arrows - Arrows - Arrows - Arrows - Arrows - Arrows -
General - 065 General - 066 General - 067 General - 068 General - 069 General - 070 General - 071 General - 072
Arrows - Arrows - Arrows - Arrows - Arrows - Arrows - Arrows - Arrows -
General - 073 General - 074 General - 075 General - 076 General - 077 General - 078 General - 079 General - 080
Arrows - Arrows - Arrows - Arrows - Arrows - Arrows - Arrows - Arrows -
General - 081 General - 082 General - 083 General - 084 General - 085 General - 086 General - 087 General - 088
Arrows - Arrows - Arrows - Arrows - Arrows - Arrows - Arrows - Arrows -
General - 089 General - 090 General - 091 General - 092 General - 093 General - 094 General - 095 General - 096

/2 - ) =, 2 =y a \ /2 =
\ﬂ \g \m m \a \m
Arrows - Arrows - Arrows - Arrows - Arrows - Arrows - Arrows - Arrows -
General - 097 General - 098 General - 099 General - 100 General - 101 General - 102 General - 103 General - 104
/2 )
\m
Arrows - Arrows -
General - 105 General - 106
ARROW 000 ARROW 001 ARROW 002 ARROW 003 ARROW 004 ARROW 005 ARROW 006 ARROW 007
ARROW 008 ARROW 009 ARROW 010 ARROW 011 ARROW 012 ARROW 013 ARROW 014 ARROW 015
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ARROWS GREEN

ARROW 016

N
N
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=
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¥
L )
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4
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N

ARROW 044
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s 3
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g
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"
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-
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¥
'

ARROW 054

ARROW 055

€
»

\ 4
2 3

ARROW 056

ARROW 057
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!
1

ARROW 062

ARROW 063

!
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ARROW 064
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1
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«
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ARROW 091
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ARROW 092 ARROW 093 ARROW 094 ARROW 095 ARROW 096 ARROW 097 ARROW 098 ARROW 099
ARROW 100 ARROW 101 ARROW 102 ARROW 103 ARROW 104 ARROW 105 ARROW 106 ARROW 107

ARROW 108

ARROW 109

v

ARROW 110

-

ARROW 111

ARROW 112

)

h 4
A

ARROW 114
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y
A
A
y
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v
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ARROW 117

ARROW 118
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ARROW 121
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ARROW 123
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ARROW 125
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ARROW 127

ARROW 128

ARROW 129
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ARROW 130

ARROW 131
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ARROW 133 ARROW 134 ARROW 135 ARROW 136 ARROW 137 ARROW 138 ARROW 139 ARROW 140
ARROW 141 ARROW 142 ARROW 143 ARROW 144 ARROW 145 ARROW 146 ARROW 147 ARROW 148

U

i
i)

)

)
¢,
G
C
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ARROW 170 ARROW 171 ARROW 172 ARROW 173 ARROW 174 ARROW 175 ARROW 176 ARROW 177
ARROW 178 ARROW 179 ARROW 180 ARROW 181 ARROW 182 ARROW 183 ARROW 184 ARROW 185
[ |
[ |
[ | O EEE * * mEmm H
* s
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ARROW 186 ARROW 187 ARROW 188 ARROW 189 ARROW 190 ARROW 191 ARROW 192 ARROW 193
——— —— /
— \ —
ARROW 194 ARROW 195 ARROW 196 ARROW 197 ARROW 198 ARROW 199 ARROW 200 ARROW 201
ARROW 202 ARROW 203 ARROW 204 ARROW 205 ARROW 206 ARROW 207
ARROW-049- ARROW-049- ARROW-049- ARROW-049- ARROW-050- ARROW-050- ARROW-050- ARROW-050-
BLUE GREEN RED YELLOW BLUE GREEN RED YELLOW
*--- *--- *--- q:II:II:II:I ---* ---* ---* |:||:||:||£l>
ARROW-051- ARROW-051- ARROW-051- ARROW-051- ARROW-052- ARROW-052- ARROW-052- ARROW-052-
BLUE GREEN RED YELLOW BLUE GREEN RED YELLOW
o a 7] O
O u] 7] O
O O 7] o | a | O
u] O u} O * * * < b
u} O u} 1]
ARROW-053- ARROW-053- ARROW-053- ARROW-053- ARROW-054- ARROW-054- ARROW-054- ARROW-054-
BLUE GREEN RED YELLOW BLUE GREEN RED YELLOW
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ARROWS OUTLINED
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a

ARROW-055- ARROW-055- ARROW-055- ARROW-055- ARROW-068- ARROW-068- ARROW-068- ARROW-068-
BLUE GREEN RED YELLOW BLUE GREEN RED YELLOW

ARROW-069- ARROW-069- ARROW-069- ARROW-069- ARROW-072- ARROW-072- ARROW-072- ARROW-072-
BLUE GREEN RED YELLOW BLUE GREEN RED YELLOW

U
U
U
a
=3
=
=
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ARROW-073-
BLUE
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GREEN

ARROW-073-
RED
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YELLOW

ARROW-074-
BLUE

ARROW-074-
GREEN
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YELLOW
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&
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C
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ARROW-075-
BLUE

ARROW-075-
GREEN

ARROW-075-
RED

ARROW-075-
YELLOW

ARROW-080-
BLUE

ARROW-080-
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YELLOW
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A
A
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ARROW-081-
BLUE
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RED
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YELLOW

ARROW-133-
BLUE

ARROW-133-
GREEN

ARROW-133-
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ARROW-149-
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RED
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YELLOW
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YELLOW
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ARROWS OUTLINED
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